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THI ẾT KẾ KHUÔN  

TRONG PRO/ENGINEER WILDFIRE 2.0  

Để thực hiện công việc này trên phần mềm Pro/Engineer bạn cần thực hiện những bước sau: 

- Sử dụng module Part để thiết kế chi tiết mẫu, gắn hệ trục tọa độ xác định hướng tách khuôn. 

- Sử dụng module MANUFACTURING để thiết kế khuôn theo mẫu được xây dựng ở module 

Part. 

- Mô phỏng quá trình mở khuôn tạo sản phẩm. 

 Để truy nhập vào module Manufacturing thực hiện việc thiết kế khuôn mẫu bạn cần tiến hành 

các bước sau: 

- Khởi động chương trình Pro/Engineer Wildfire 2.0. 

- Thiết lập thư mục làm việc cho bạn. 

- Pick chuột chọn biểu tượng  để tạo một thiết kế mới, lúc này hệ thống chương trình 

Pro/Engineer sẽ trình bày một cửa sổ New yêu cầu bạn lựa chọn các chế độ làm việc cho bản thiết kế 
của bạn. Để truy nhập vào chương trình thiết kế khuôn mẫu bạn hãy pick chuột chọn Manufacturing  

> Mold Cavity  > Đặt tên cho bản vẽ ở mục Name > Bỏ chế độ mặc định đơn vị, hình 8.1. 

 

 

 

 

 

 

 

 

 

 

 

- Pick chuột chọn OK  để thoát khỏi cửa sổ New, Pro/Engineer sẽ trình bày cửa sổ New File 

Options yêu cầu bạn lựa chọn đơn vị cho bản thiết kế này > Pick chuột chọn 

mmns_mfg_mold, hình 8.2. 

- Pick chuột chọn OK  để thoát khỏi cửa sổ New File Options, lúc này bạn đã vào môi trường 

thiết kế khuôn mẫu với ba mặt phẳng chính và hai mũi tên màu vàng đi kèm là Menu Manager, 

hình 8.3. 

Hình 8.1 
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  Ở Menu Manager, Pro/Engineer trình bày một số chức năng chính để hỗ trợ bạn tính toán và 

thiết kế khuôn mẫu. 

+ Mold Model: Cho phép bạn tạo mẫu, hay nhập mẫu đã được thiết kế từ module Part. 

+ Feature: Cho phép bạn thiết kế đường dẫn liệu, các lệnh ở chức năng này được thực hiện 

giống như ở module Part. 

+ Shrinkage: Cho phép bạn tính toán độ co rút của sản phẩm, theo vật liệu. 

+ Parting Surf: Thiết kế mặt phân khuôn. 

+ Mold volume: Cho phép bạn phân mảnh khuôn. 

+ Mold Comp: Kết hợp các mảnh khuôn. 

+ Mold Opening: Mô phỏng tách khuôn. 

+ Molding : Tạo sản phẩm đúc. 

  Để làm quen với module Manufacturing, chúng tôi xin trình bày với bạn đọc một ví dụ thiết 
kế khuôn đúc ly nhựa, theo các bước sau: 

1. Bước 1: Sử dụng module Part để thiết kế chi tiết mẫu (ly nhựa), hình 8.4. 

 

 

 

 

 

 

 

 

Hình 8.2 

Hình 8.3 

Hình 8.4 

Hình 8.5 
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2. Bước 2: Gắn hệ trục tọa độ xác định hướng tách khuôn lên chi tiết mẫu, bằng cách pick chuột 

chọn biểu tượng  (Datum Coordinate System Tool) bên phải màn hình vẽ. Pro/Engineer 

trình bày cửa sổ COORDINATE SYSTEM  yêu cầu bạn lựa chọn đối tượng để xác định vị trí 
cho hệ trục tọa độ, hình 8.5. 

  Pick chuột chọn lần lượt ba mặt phẳng Front , Top, Right để xác định hệ trục tọa độ, lúc này 

hệ trục tọa độ sẽ được gắn lên trên ba mặt phẳng Front , Top, Right, hình 8.6. 

  Chú ý: Hệ trục tọa độ được gắn lên chi tiết bạn phải thay đổi vị trí các trục sao cho trục OZ 

luôn luôn hướng ra khỏi chi tiết hay vuông góc với mặt phân khuôn. 

 

 

 

 

 

 

 

 

 

 

 

 

  Pick chuột chọn OK  để chấp nhận và thoát khỏi cửa sổ COORDINATE SYSTEM , lúc này 

hệ trục tọa độ CSO được tạo ra trên mẫu, hình 8.7. 

 

 

 

 

 

 

 

 

 

 

Hình 8.6 

Hình 8.7 
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  Pick chuột chọn biểu tượng  (Save) để lưu bài tập này. Pick chuột chọn File > Close 

Window để tắt module Part. 

3. Bước 3: Truy nhập vào module MANUFACTURING để thiết kế khuôn theo mẫu, bằng cách 

pick chuột chọn File > New > Manufacturing  > Mold Cavity  > Nhập tên cho bản thiết kế mới 

này là KhuonLy , hình 8.8. 

 

 

 

 

 

 

 

 

 

 

 

 

- Pick chuột chọn OK  để thoát khỏi cửa sổ New, Pro/Engineer sẽ trình bày cửa sổ New File 

Options yêu cầu bạn lựa chọn đơn vị cho bản thiết kế mới > Pick chuột chọn 

mmns_mfg_mold, hình 8.9. 

- Pick chuột chọn OK  để thoát khỏi cửa sổ New File Options và vào môi trường thiết kế 
khuôn, hình 8.10. 

 

 

 

 

 

 

 

 

 

 

Hình 8.8 

Hình 8.9 

Hình 8.10 
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4. Bước 4: Nhập chi tiết mẫu, để nhập chi tiết mẫu bạn hãy pick chuột chọn Mold Model từ cửa 

sổ Menu Manager > Pick chuột chọn Locate RefPart để lấy mẫu từ trình thiết kế Part.prt, 

hình 8.11. 

  Sau khi bạn pick chuột chọn Locate 

RefPart, hệ thống Pro/Engineer sẽ trình bày 

cửa sổ Open yêu cầu bạn tìm địa chỉ chứa 

mẫu và cửa sổ Layout để bạn xác định vị trí 
đặt mẫu và số mẫu cần tạo ra trên khuôn, hình 

8.12. 

 

 

 

 

 

   

 

 

 

 

 

- Từ cửa sổ Open bạn chọn chi tiết mẫu với tên ly.prt  > Pick chuột chọn Open để chấp nhận chi 

tiết này. Pro/Engineer sẽ trình bày cửa sổ Create Reference Model yêu cầu bạn xác định vị trí 
chuẩn cho mẫu, hình 8.13. 

 

 

 

 

 

 

 

 

- Pick chuột chọn Ok để chấp nhận và thoát khỏi cửa sổ Create Reference Model. 

Hình 8.11 

Hình 8.12 

Hình 8.13 
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- Tại vị trí Ref.Model Origin and Orient ở cửa sổ Layout > Pick chuột chọn biểu tượng  để 
xác định gốc tọa độ trên chi tiết mẫu, Pro/Engineer sẽ trình bày cửa sổ KHUONLY.REF  chứa 

chi tiết mẫu yêu cầu bạn pick chuột chọn gốc tọa độ trên chi tiết mẫu, hình 8.14. 

 

 

 

 

 

 

 

 

 

 

- Pick chuột chọn Standard > Select > Pick chuột chọn gốc tọa độ đã được xác lập ở module 

Part trên chi tiết mẫu với tên CSO. 

- Tại vị trí Layout Origin  ở cửa sổ Layout > Pick chuột chọn biểu tượng  để xác định gốc 

tọa độ của chi tiết mẫu trên ba mặt phẳng chuẩn > Pick chuột chọn Select > Pick chuột chọn 

gốc tạo độ đang hữu hiệu trên màn hình vẽ với tên MOLD_DEF_CSYS. 

- Tại vị trí Layout, Pro/Engineer cho bạn một số lựa chọn để xác định số lượng sản phẩm cần 

tạo ra trên khuôn. 

+ Single: Thiết kế khuôn tạo một sản phẩm. 

+ Rectangular: Thiết kế khuôn có số lượng sản phẩm bố trí treo hình chữ nhật. 
+ Circular : Thiết kế mà sản phẩm được bố trí theo hình tròn. 

+ Variable: Thiết kế khuôn mà sản phẩm cách nhau một khoản tùy chọn. 

  Ở bài tập này bạn hãy pick chuột chọn Rectangular: Thiết kế khuôn có số lượng sản phẩm bố 

trí treo hình chữ nhật. Nhập số sản phẩm theo phương X là 2, số sản phẩm theo phương Y là 2 

và khoảng cách giữa các sản phẩm 120mm > Pick chuột chọn Preview để xem trước, hình 8.15. 

- Pick chuột chọn OK  để chấp nhận và thoát khỏi cửa sổ Layout > Pick chuột chọn 

Done/Return > Done/Return. 

5. Bước 5: Tạo phôi khuôn, để thực hiện việc tạo phôi cho khuôn bạn hãy pick chuột chọn 

Mold Model > Create > Workpiece > Manual. Pro/Engineer sẽ trình bày cửa sổ Component 

Create, pick chuột chọn Part từ vị trí Type, pick chuột chọn Solid từ vị trí Sub-Type, nhận tên 

Phoikhuon ở ô Name, hình 8.16. 

Hình 8.14 
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- Pick chuột chọn OK  để đóng cửa sổ Component Create lại > Pick chuột chọn Create 

Features từ cửa sổ Creation Options, hình 8.17. 

 

 

 

 

 

 

 

 

 

Hình 

Hình 

Hình 8.17 
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- Pick chuột chọn OK  > Solid > Prorusion > Extrude > Solid > Done > Pick chọn Placement 

đang hiện màu đỏ ở góc dưới bên trái màn hình vẽ > Pick chuột chọn Define, hình 8.18. 

 

 

 

 

 

 

 

 

  Lúc này hệ thống Pro/Engineer yêu cầu bạn lựa chọn mặt phẳng vẽ phác, pick chuột chọn mặt 
MAIN_PATING_PLN  và mặt MOLD_FRONT , hình 8.19. 

 

 

 

 

 

 

 

 

- Pick chuột chọn Sketch để đóng cửa sổ Sketch lại, lúc này hệ thống Pro/Engineer yêu cầu bạn 

chọn chuẩn kích thước > Pick chuột chọn mặt phẳng MOLD_FRONT  và MOLD_RIGHT  làm 

2 chuẩn kích thước, hình 8.20. 

 

 

 

 

 

 

 

 

 

Hình 8.18 

Hình 8.19 

Hình 8.20 
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- Pick chuột chọn Close để đóng cửa sổ 

References lại và vào môi trường vẽ phác. 

Pick chuột chọn biểu tượng  (Create 

Rectangle) bên phải màn hình vẽ để gọi lệnh 

vẽ tứ hiện xác định tiết diện phôi khuôn, 

hiệu chỉnh kích thước phôi khuôn 

(250X250), hình 8.21. 

 

- Pick chuột chọn biểu tượng  để kết thúc 

lệnh vẽ tiết diện phôi khuôn > Pick chuột 

chọn Option ở góc dưới bên trái màn hình 

vẽ để xác định chiều dày của khuôn trên và 

khuôn dưới. Bạn hãy nhập giá trị chiều dày 

khuôn trên là 50mm, khuôn dưới là 70mm, 

hình 8.22. 

 

 

 

 

 

  

 

 

 

- Pick chuột chọn các biểu tượng 

 để xem trước kết quả và 

kết thúc lệnh tạo phôi khuôn > Pick 

chuột chọn Done/Return > 

Done/Return. Phôi khuôn được tạo 

ra có mà xanh trong suốt, hình 8.23. 

6. Bước 6: Tạo mặt phân khuôn. 

  Để tạo mặt phân khuôn bạn hãy 

pick chuột chọn Parting Surf từ cửa 

sổ Menu Manager. Pick chuột chọn 

Create, Pro/Engineer sẽ trình bày 

Hình 8.21 

Hình 8.22 

Hình 8.23 
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cửa sổ Parting Surface Name yêu cầu bạn nhập tên cho mặt phân khuôn, hình 8.24. 

  

 

 

 

 

 

 

 

 

 

 

  Ở mục Name bạn hãy nhập tên cho mặt phân khuôn là 

Matphankhuon, sau đó pick chuột chọn Ok để chấp nhận, 

hình 8.25. 

- Pick chuột chọn Add > Shadow > Done. Pro/Engineer sẽ 
trình bày cửa sổ FEATURE REFS yêu cầu bạn pick chuột 

chọn mẫu sản phẩm. Bạn pick chuột chọn 4 mẫu sản phẩm 

đang hữu hiệu trên màn hình. 

  Chú ý: Sau khi chọn mẫu thứ nhất để chọn đuợc mẫu tiếp 

theo bạn hãy nhấn phím Ctrl và pick chuột chọn các mẫu còn 

lại, mẫu được chọn sẽ chuyển sang màu đỏ, hình 8.26. 

 

 

 

 

 

 

 

 

 

 

 

Hình 8.24 

Hình 8.25 

Hình 8.26 
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- Pick chuột chọn Done Refs, ngay lập tức hệ thống Pro/Engineer yêu cầu bạn lựa chọn mặt 
phẳng để làm mặt phân khuôn > Pick chuột chọn mặt MAIN_PARTING_PLN  làm mặt phân 

khuôn, hình 8.27. 

 

 

 

 

 

 

 

 

 

 

- Pick chuột chọn Done/Return để ra lệnh cho hệ thống Pro/Engineer thực hiện lệnh tạo mặt 
phân khuôn.  

- Pick chuột chọn OK  từ cửa sổ Shadow Surface > Pick chuột chọn Done/Return hai lần để 
kết thúc lệnh tạo mặt phân khuôn, lúc này mặt phân khuôn hiện lên trên sản phẩm, hình 8.28. 

 

 

 

 

 

 

 

 

 

7. Bước 7: Phân mãnh khuôn (khuôn đực, khuôn cái). 

  Ở bước này, chúng tôi sẽ hướng dẫn bạn đọc các 

thao tác thực hiện việc phân mãnh cho khuôn, để 
thực hiện việc phân mãnh khuôn bạn hãy pick chuột 

chọn Mold Volume từ cửa sổ MOLD  > Pick chuột 

chọn Split để báo cho Pro/Engineer biết bạn muốn 

tách khuôn.  

Hình 8.27 

Hình 8.28 

Hình 8.29 
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  Ngay sau khi bạn pick chuột chọn Split từ cửa sổ MOLD VOL . Pro/Engineer sẽ trình bày 

cửa sổ SPLIT VOLUME  với một số lựa chọn kèm theo, hình 8.30. 

 

 

 

 

 

 

 

 

 

 

 

+ Two Volumes: Tạo khuôn làm hai mãnh 

(Khuôn đực và khuôn cái), ví dụ hình 8.31. 

   Trong đó: 

1: Mặt phân khuôn. 

2: Hai mãnh khuôn, khuôn đực và khuôn cái. 

+ One Volume: Tạo khuôn một mãnh, hay một 

lồng khuôn, ví dụ hình 8.32. 

   Trong đó: 

1: Tạo kết cấu khuôn. 

2: Tách mãnh khuôn. 

+ All Wrkpcs : Tách nguyên cả khối. 

+ Sel Comp: Chỉ rõ các phần để phân chia khuôn 

thành nhiều mãnh. 

 Ví dụ hình 8.33, khuôn hai mãnh có bố trí lõi 

bên trong. 

 Trong đó: 

1: Tạo khuôn. 

2: Xác định lõi khuôn. 

3: Xác định mặt phân khuôn. 

Hình 8.30 

Hình 8.31 

Hình 8.32 
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4: Mô phỏng quá trình tách khuôn tạo sản 

phẩm đúc. 

   Ở bài tập này, để tạo khuôn thành hai mãnh, 

bạn hãy pick chuột chọn Two Volumes > All 

Wrkpcs > Done. Pro/Engineer sẽ trình bày 

dòng nhắc “Select parting surface” yêu cầu bạn 

chọn mặt phân khuôn > Bạn rê chuột và pick 

chọn mặt phân khuôn đã được tạo ở bước 6, 

ngay lập tức mặt phân khuôn và các mẫu sẽ 
chuyển sang màu đỏ, hình 8.34. 

- Pick chuột chọn OK  từ cửa sổ, hệ thống 

Pro/Engineer sẽ trình bày cửa sổ Volume Name 

yêu cầu bạn đặt tên cho nửa khuôn trên, ở đây 

bạn hãy nhập tên Khuontren , hình 8.34. 

  

 

 

 

 

 

 

 

 

 

 

- Pick chuột chọn Ok từ cửa 

 sổ Volume Name, và Pro/Engineer  

yêu cầu bạn đặt tên cho nửa khuôn  

dưới. 

 Ở đây bạn cũng thực hiện tương  

tự như trên với tên Khuonduoi,  

hình 8.35. 

 

Hình 8.33 

Hình 8.34 

Hình 8.34 

Hình 8.35 
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- Pick chuột chọn Ok để đóng cửa sổ Volume Name lại > Pick chuột chọn 

Done/Return.  

  Chú ý: Sau khi thực hiện bước này bạn nên thực hiện việc che dấu phôi. 

8. Bước 8: Kết hợp các mãnh khuôn với lệnh Mold Comp. 

   Để gọi lệnh kết hợp các mãnh khuôn bạn hãy pick chuột chọn Mold 

Comp từ cửa sổ MOLD  > Pick chuột chọn Extract , hình 8.36. 

Pro/Engineer trình bày cửa sổ Create Mold Component yêu cầu bạn chọn 

các mãnh khuôn. Bạn giữ phím Ctrl  và pick chuột chọn lần lượt 

Khuonduoi và Khuontren  từ cửa sổ Create Mold Component, hình 8.37. 

 

 

 

 

 

 

 

 

 

 

- Pick chuột chọn Ok để đóng cửa sổ Create Mold Component lại > Pick chuột chọn 

Done/Return từ cửa sổ Mold Comp, lúc này Khuontren.prt  và Khuonduoi.prt  sẽ xuất hiện 

trên Model Tree. 

9. Bước 9: Mở khuôn với lệnh Mold Opening. 

  Từ cửa sổ MOLD bạn hãy pick chuột chọn Mold Opening để gọi lệnh mở khuôn > Pick 

chuột chọn Define Step để định nghĩa bước mở khuôn > Define Move để thực hiện việc di 

chuyển các mãnh khuôn. Pro/Engineer trình bày cửa sổ Select yêu cầu bạn pick chuột chọn nửa 

khuôn trên > Pick chuột chọn khuôn trên > Pick chuột chọn Ok từ cửa sổ Select để chấp nhận 

việc chọn mãnh khuôn trên của bạn. Ngay sau khi bạn chọn Ok, Pro/Engineer sẽ yêu cầu bạn 

chọn mặt phẳng tham chiếu để xác định phương dịch chuyển khuôn trên > Pick chuột chọn mặt 
trên cùng, ngay lập tức hệ thống Pro/Engineer sẽ trình bày mũi tên màu đỏ chỉ phương di 

chuyển khuôn trên đi kèm dòng nhắc “Enter movement along”, yêu cầu bạn nhập khoảng cách 

di chuyển khuôn trên. Ở bài bài tập, này bạn nhập khoảng cách dịch chuyển là 100mm, sau đó 

nhấn phím Enter để hệ thống ghi nhận giá trị này, hình 8.38. 

 

Hình 8.36 

Hình 8.37 
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- Pick chuột chọn Done từ cửa sổ 

DEFINE STEP, ngay lập tức hệ 
thống chương trình Pro/Engineer sẽ 
tự động dịch chuyển khuôn trên theo 

phương mũi tên đỏ một khoản 

100mm, hình 8.39. 

  Bạn cũng thực hiện tương tự đối 

với khuôn dưới và thu kết quả như 

hình 8.40. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- Pick chuột chọn Done/Return để đóng cửa sổ MOLD OPEN  lại kết thúc lệnh mở khuôn. 

Hình 8.38 

Hình 8.39 

Hình 8.40 

Khuôn trên 
Khuôn dưới 

Mặt phân 
khuôn 

Sản phẩm 
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10. Bước 10: Tạo sản phẩm với lệnh Molding . 

  Từ cửa sổ MOLD bạn hãy pick chuột chọn Molding  gọi lệnh tạo sản phẩm > Pick chuột chọn 

Create, Pro/Engineer sẽ trình bày dòng nhắc “Enter Part name [PRT0001]:” yêu cầu bạn đặt 
tên sản phẩm, bạn nhập tên Sanpham sau đó nhấn phím Enter để hệ thống ghi nhận giá trị này.  

  Để mô phỏng quá trình tách khuôn bạn hãy pick chuột chọn Mold Opening > Explode > 

Open Next, lúc này bạn sẽ quan sát được quá trình tách khuôn tạo sản phẩm trên màn hình vẽ, 
hình 8.41. 

 

 

 

Hình 8.41 


